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You can type French accents on Windows using different keyboard layouts like International and UK Extended.For Apple computers, typing French accents is simple with the Option key, KeyCaps, or Special Character Palette.Linux users can use the Character Palette or Compose Key to easily type French accents. You don't need to buy a French
keyboard or any software to type French accents. There are several different ways to type them on Windows, Apple, and Linux computers. You have several options, based on your computer and current keyboard: If you currently use the English-U.S. keyboard layout, the international keyboard is far and away your best option for typing accents. It is
not a separate keyboard, just a Windows setting.If you use an English-U.K. keyboard, the U.K. extended keyboard is the best.Your other options are the French keyboard, the Canadian French keyboard, and ALT codes. Depending on your operating system, you can choose between: Option key accentsKeyCapsSpecial character paletteSetting the
language of your operating system to French For U.S. English keyboard users, the international keyboard (which is not a physical keyboard, but rather a simple Control Panel setting) is the easiest and most convenient method for typing French accents because it maintains the QWERTY layout, with just a few changes and additions: To type accent
grave (, , etc), type ~ (to the left of 1) then the vowel.Accent aigu (), type ' (single quote) then e.Cdille (), type ' then c.Circonflexe (), type ™ (shift + 6) then e.Trma (), type " (shift + ') then o0.To type French quotation marks use ctrl + alt + [ and ], respectively. The minor disadvantage of the international keyboard is that when you want to type the
"helping" character (e.g., single or double quotes) by itself rather than above a vowel, you have to type the symbol then hit the space bar. For example, to type c'est, type c then ' then hit the spacebar then type e s t. It takes a little while to get used to typing that extra space when you just want to type ' or " Troubleshooting the international keyboard
If you are plagued by strangeness such as cst when you try to type c'est, re-read the note above. In order to use the international keyboard to type French accents, you need to select that keyboard layout. If you currently use a UK keyboard, you will probably find the UK extended keyboard the easiest way to type French accents. The keyboard layout
will be maintained, but you can type most accents with the AltGr key, which is located to the right of the spacebar. To type accent grave (, , etc), type ~ (to the left of 1) then the vowel.Accent aigu (), click AltGr and e at the same time.Cdille (), click AltGr and c at the same time.Circonflexe (), click AltGr and ~ at the same time, then the vowel.Trma ()
click AltGr and " at the same time, thenthe vowel. In order to use the UK extended keyboard to type French accents, you need to select that keyboard layout. Close up of a white french azerty computer keyboard.Delpixart/ Getty Images Plus The layout of the French keyboard, known as AZERTY, is somewhat different than the layouts of other
keyboards. If you're used to QWERTY, I recommend that you use the international keyboard.Otherwise, with the French keyboard layout, you'll find - among other changes - that the A and Q have switched places, W and Z have switched, and M is where the semi-colon used to be. In addition, numbers require the shift key.On the other hand, you can
type the grave accent (, , ) and acute accent () with a single key, and the other accented letters with a combination of two keys: To type anything with a circumflex (, , etc), type ~ then the vowelFor a trma, (, , etc), type and the vowel In order to use the French keyboard to type French accents, you need to select that keyboard layout. French Canadian
keyboard.Public Domain / Wikimedia commons The layout of this keyboard is similar to QWERTY, making it somewhat simpler if that is what you are used to (though I still believe that the international keyboard is better).Typing accents on the Canadian French keyboard is fairly simple: To type an acute accent (), type (next to the right-hand shift key)
and then eTo type a grave accent (, , ), type ' (apostrophe / single quote) then the vowelThe circumflex and trma are in the upper-right corner, side by side next to the enter keyFor, type (left of "enter") and then c In order to use the Canadian French keyboard to type French accents, you need to select that keyboard layout. In order to use one of these
alternate keyboard layouts, you need to add it to Windows. Once you've done this, you can either set it as your default keyboard or use alt plus shift to toggle between two or more layouts. The way to do this is slightly different for each operating system. Open Control PanelUnder "Clock, Language, and Region," click "Change input methods"Click
"Options" to the right of your languageClick "Add an input method"Scroll down to the language you want to add, click + next to it, then select the layout*Click OK in each dialog window. Open Control PanelUnder "Clock, Language, and Region," click "Change keyboards or other input methods"Click "Change keyboards"Click AddScroll down to the
language you want to add, click + next to it, then select the layout*Click OK in each dialog window.To use the layout, click the language input button on the taskbar (it probably says EN) and select it. Open Control Panellf in Classic View, click "Control Panel Home" in the upper-left cornerUnder "Clock, Language, and Region," click "Change
keyboards or other input methods"Click "Change keyboards"Click "Add"Scroll down to the language you want to add, click + next to it, then select the layout*Click OK in each dialog window. Open Control PanelDouble-click "Regional and Language Options"Click "Languages"Click "Details"Click "Add"Under "Input Language," pick the language you
want to add*Under "Keyboard layout/IME" make your selectionClick OK in each dialog window. Open Control PanelDouble-click "Keyboard"Click "Language"Click "Properties," "Settings," or "Details" (whichever you see)Click "Add"Pick the layout you want to add*Click OK in each dialog window. Open Control Panel (via Start menu or My
Computer)Double-click "Keyboard"Click "Input Locales"Click "Change"Click "Add"Pick the layout you want to add*Click OK in each dialog window. *Layout names:International Keyboard: English (United States), US-Int'1UK Extended Keyboard: English (UK - extended)French Keyboard: French (Standard)French Canadian Keyboard: French
(Canadian) The best way to type accents on a PC is by using the international keyboard, which requires a simple control panel configuration - there is no keyboard to purchase or software to download. If you're really set against the international keyboard, you can type accented characters with ALT codes, which use the ALT key and a 3 or 4 digit
code. However, ALT codes only work with the numeric keypad, notthe row of numbers across the top of your keyboard. So they won't work on a laptop unless you hit number lock to activate the number pad "built into" the right-side of your keyboard, which is a big hassle because then the letters won't work. Bottom line, if you're on a laptop, choose a
different keyboard rather than messing around with ALT codes. To type accents with ALT codes, hold down the ALT key, then on the numeric keypad type the three or four digits listed here. When you release the ALT key, the character will appear.a with grave accentALT + 133ALT + 0192a with circumflexALT + 131ALT + 0194a with trmaALT +
132ALT + 142a e ligatureALT + 145ALT + 146¢ with cedillaALT + 135ALT + 128e with acute accentALT + 130ALT + 144e with grave accentALT + 138ALT + 0200e with circumflexALT + 136ALT + 0202e with trmaALT + 137ALT + 0203i with circumflexALT + 140ALT + 0206i with trmaALT + 139ALT + 02070 with circumflexALT + 147ALT +
02120 e ligatureALT + 0156ALT + 0140u with grave accentALT + 151ALT + 0217u with circumflexALT + 150ALT + 0219u with trmaALT + 129ALT + 154French quotation marksALT + 174ALT + 175Euro symbolALT + 0128 To type accents on an Apple with the option key, hold down the option key while pressing the key(s) in bold in this list. For
example, to type , hold the option key while typing i, then release both and type e. To type , hold option, type i, release and type i again. In these instructions, "and" means to keep holding the option key and the first key listed while typing the second. "Then" means to release the option key and the first key before typing the second. acute accentHold
option key and e then egrave accent, , Hold option key and * then a, e, or ucedillaHold option key and ccircumflex, , , , Hold option key and i then a, e, i, 0, or utrma, , Hold option key and u then e, i, or uoe ligatureHold option key and g To type any of the above as capital letters, add shift key to the first step. So for , hold shift key, option key, and e,
then e.French quotation marksHold option key and \Hold option key and shift key and \Euro symbolHold option key and shift key and 2KeyCaps (OS9 and below) is similar, but it gives you a keyboard to click. Click on the apple on the top left of the screenOpen KeyCaps (a little keyboard will appear on the desktop)Hold down the option key - the
accents will appear and you can click on them with the mouse.For example, to type , hold option, click *, type u. The accented character will appear. Opening the special character palette to type accents on a Mac: Click edit in the menubarClick Special charactersSelect Roman from the View pulldown menuSelect the Accented Latin character
paletteKeep the palette open for use in any application Using the palette: Place your cursor at the point in the document where you want an accented characterClick the desired accented character in the paletteClick Insert at the bottom of the palette You can type French accents and immerse yourself in French at the same time on an Apple OSX by
setting your system language to French so that your OS, as well as most Apple software, use French: Go to System PreferencesChoose InternationalChange the system operating language to French Here are two ways to type accents in Linux: Character Palette (Ubuntu 10.04) Right-click on the top bar and click on "Add to Panel," select and add
"Character Palette." The small arrow on the left will give a choice of palettes which you can modify to contain any accented or other character required. Left-click a character, then hold down Control Key and type V to insert it at the cursor position. Compose Key Specify a particular unused key (e.g., the Windows key) to be the Compose Key, then you
can hold down Compose Key and type e” to get, or o" to get . The combinations are pretty intuitive. Where to specify the Compose Key changes from system to system. On a SuSE installation, go to Control Center > Accessibility Options > Keyboard Properties > Options > Compose Key option. If you have an Android tablet or smartphone, you can
download the app Smart Keyboard to get access to accented letters.Download the trial version or pro version of the app and install it on your deviceGo to "Language and keyboard" and check the "Smart Keyboard" boxGo to "Settings > Language > Current Language" and choose "English (International)"Go any app with a text box and press inside it in
order to activate a popup menu. Choose "Input Method" and then "Smart Keyboard" You're all set! Now you can type accents by pressing and holding the button for the unaccented letter for a moment. A list of accented letters will pop up for you to choose from.For example, to type , press and hold the letter a, then choose . To type, , , or, press and
hold e, then make your selection. For , press and hold the letter c. To type accented letters on an iPhone or iPad, press and hold the button for the unaccented letter for a moment. A list of accented letters will pop up for you to choose from. For example, to type , press and hold the letter a, then choose . To type, , , or, press and hold e, then make
your selection. For , press and hold the letter c. Download Article Download Article This method teaches you how to type French-accented characters using any computer, phone, or tablet. If you're using a phone or tablet, you can just press and hold the corresponding letter key to open a set of accent options. If you're using Windows, you can use the
International Keyboard, which lets you easily switch between French and English. Most Mac apps let you insert French characters the same way you'd do it on an iPhone, but others require keyboard shortcuts. 1Tap the field in which you want to type a French-accented letter. This springs open your keyboard.Typing accented characters is generally
the same regardless of keyboard app. You should be able to use this method on any Android, iPhone, or iPad.If you're using the SwiftKey keyboard, you'll need to enable accented characters first. Here's how:[1]Tap the + to the left of the prediction bar on the keyboard.Tap Keys.Slide the "Accented Characters" switch to the On (purple) position. 2Tap
and hold the key with the letter that needs the accent. In about a second, you'll see all possible accents for that letter. Don't lift your finger from the screen.[2]If you have an iPhone 6, 7, 8, or X-series with 3D Touch, use a light tap-and-hold instead of a hard press. If you press the key too hard, you'll see a cursor that can move around the screen rather
than accent options. Advertisement 3Drag your finger to the accented letter. This highlights the selected letter.[3]4Lift your finger from the screen. The selected accented letter will appear.[4] Advertisement 1Try using a shortcut key combination. If you're typing in a word processing app like Microsoft Word or similar, you can press a combination of
keys to type French-accented characters. This is helpful for when you don't need to type in French very often. Here's the list of shortcuts:[5]: Press and hold Control+', and then type an e. : Press and hold Control+", then press the key for the desired vowel.: Press Control+, and then type a c. : Press Control+”, then press the key for the desired
vowel. : Press Control+:, then press the key for the desired vowel.20pen the Start menu and click Settings . If you need to type in French a little more often, you can use the International Keyboard. This keyboard lets you use fast keyboard shortcuts in any app to create accented characters without having to change your whole keyboard layout.3Click
Time & Language. It's in the third row of settings.[6]4Click Language. It's in the left panel.5Scroll down and click your language. It's near the bottom of the right panel below the "Add a Language" option. Some buttons will expand below your language.6Click Options below your language.7Scroll down and click + Add a keyboard. It's under the
"Keyboards" header in the right panel. A list of keyboards will appear.[7]8Click United States-International or UK International Keyboard in the menu. This adds the keyboard to the list under the "Keyboards" header.You can now close the Settings window by clicking the X at its top-right corner.9Click your keyboard language on the taskbar. The
language appears to the left of the clock in the taskbar, which usually runs along the bottom of the screen. A menu will expand.For example, if you're using US English, click ENG US beside the clock.10Select ENG INTL. You are now using the international keyboard.11Open the app in which you need to type French accented letters. This can be a
word processing app, a web browser, or any other app that allows typing.12Type the accented letter. Any of these accents will work with upper and lower-case letters.[8]: Type an apostrophe ' and then an e. : Type a backquote * (at the top-left corner of the keyboard, left of the "1" key) and then type the vowel.: Type an apostrophe ' and then a c. :
Press Shift+6 to type a caret ~ and then type the vowel. : Type a double-quote " and then the vowel.When the international keyboard is enabled, your apostrophe and quote keys will work a little different than normal. To type a regular apostrophe ' or ", you'll have to press the space bar right after.13Switch back to your normal keyboard. You'll usually
only want to switch to this keyboard when you have to type in French. To switch back, click ENG INT in the taskbar and select your default language. Advertisement 10pen the app in which you need to type French accented letters. This can be a word processing app, a web browser, or any other app that allows typing.2Press and hold the key on
which you want to add an accent. A menu with different accent options above the key will appear. Don't lift your finger from the key.[9]3Press the number below the accent you want to use. You'll want to press the corresponding number while you're still holding the letter key down on the keyboard.[10]4Release your fingers from both keys. The
selected accented letter now appears.This method may not work in all apps, though it should work in most. If you're running into problems, you can use one of a combination of keystrokes to make the accents appear. Read on to learn how.[11]5Use the Option key to insert accents. If the previous steps didn't work in the app you're using, you can use
these shortcuts instead:: Press and hold Option+e, lift your finger from Option, and then press e. : Press and hold Option+", then press the key for the desired vowel.: Press Option+C. : Press Option+i, then press the key for the desired vowel. : Press Option+u, then press the key for the desired vowel. Advertisement Add New Question Question How
do I put an accent over a letter? Marc Crabb Google Suite ExpertMarc is a translator and International Project Manager, who has been working in Google Suite for project management since 2011. As French keyboards aren't always available out of the French-speaking countries, consider using a Spanish keyboard if available as it allows you to type
most accents.Since I use a Spanish keyboard, I have almost all of the accents I need for special French characters, although I don't have dedicated keys as I would on a real French keyboard. Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine
is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating technical documentation and leading support teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various
institutions. This article has been viewed 118,584 times. Co-authors: 14 Updated: February 24, 2025 Views:118,584 Categories: French PrintSend fan mail to authors Thanks to all authors for creating a page that has been read 118,584 times. 125.1K Accent marks are a required aspect of writing in French, but many beginning French learners wonder
if they really matter. They do! However, learning how to read and write French accent marks is only part of the battle. Since we live in the twenty-first century, its important to know how to type French accents, too. But French accent marks dont appear on most US English keyboards. The good news is that typing French accents is easier than it
looks, and you dont even need a French keyboard! Learning how to type French accents will help you whether youre working with a French tutor, taking a language class, learning French words for a trip to Paris, or just working your way through the basics of French grammar. This guide covers typing French accents on English keyboards for PC,
Mac, and mobile devicesalong with how to type accent marks in Word and Google Docs. French accent marks help to determine French pronunciation and distinguish between word meanings. Learning how to use and type French accents accurately can help you communicate and have conversations in French for class, work, or travel. These are the
five French accent marks and how theyre used and pronounced. AccentUsagePronunciationExamplesaiguaydesol, mdicin AccentUsagePronunciationExamplesgraveahehoohproblme, deuxime AccentUsagePronunciationExamplescdillessfranais, garon AccentUsagePronunciationExamplestrmaayeeoohconcidence, Zo
AccentUsagePronunciationExamplescirconflexeahheheeohoohtre, htel >>Theres a movement to remove the circonflexe from French, but its still important to recognize and know which words include it! If youre wondering how to type an accent mark when youre writing a paper, essay, or article, Google Docs and Microsoft Word both have features
that allow you to insert special characters and type French accents that dont appear on the keys. In Google Docs, start by clicking Insert, then Special Characters. Two drop-down menus and a grid of symbols will pop up. Select Latin from the first drop-down menu, and then select the accented letter you want to type from the grid. In Microsoft Word,
you also begin by clicking Insert. Next, click Advanced Symbol. If the (normal text) font doesnt show up in the dropdown menu right away, navigate to the Segoe UI Symbol font. A grid of symbols will pop upselect the accented letter you want to type and click Insert. You can easily type French accents on an Apple device with Option Key Accents
codes and by using your keyboard. The modern Mac OS offers an exceptionally fast method of typing French accents, and its easy to use: AccentCodeaigu ()Press Option + e followed by the lettergrave (, , )Press Option + * (the key to the left of the 1) followed by the lettercirconflexe (, , , , )Press Option + i followed by the lettertrma (, , )Press Option
+ u followed by the lettercdille ()Press Option + ¢ Whether youre composing an email, writing in a doc, or using an app, you can use simple Mac keyboard shortcuts to type French accents. Simply hold down a letter key on your keyboard until an accent menu appears. Once the menu is visible, you can use the arrow keys to move to the accent you
want, or you can use the corresponding number key to choose an accent. A menu will only display if that letter has possible accents. Fortunately, Windows has shortcuts that make it easy to type French accents without having to install an entirely new keyboard. To enter these codes for French accent marks, use a sustained key presspress each key
one at a time, and hold it down until all the keys in the sequence are pressed down (note: dont type the + symbol). You can also use the below keyboard shortcuts in Word and Outlook to type French accents on a PC. AccentCodeaigu ()Press CTRL + (apostrophe), followed by the lettergrave (, , )Press CTRL + ~ (the key to the left of 1), followed by the
lettercirconflexe (, , , , )Press CTRL + Shift + 6, followed by the lettertrma (, , )Press CTRL + Shift + : (colon), followed by the lettercdille ()Press CTRL + , (comma), followed by c If the above codes dont work on your computer, try these Windows Alt codes for French accent marks by just using your number pad. Please note that you must have a
separate number pad to use Alt codes. AccentAlt CodeAccentAlt CodeAlt+0233A1t+0201Alt+0224A1t+0192A1t+0232A1t+0200A1t+0249A1t+0217A1t+0226A1t+0194A1t+0234A1t+0202A1t+0238A1t+0207A1t+0244A1t+0212A1t+0251Alt+0219A1t+0235A1t+0203A1t+0239A1t+0207Alt+0252A1t+0220A1t+0231A1t+0199 For iPhone, Android, and tablet
keyboards, hold down any letter, and French accent options will appear (with other non-French accents, as well). If you want to type e with an accent, hold down the e key, and youll instantly see these options pop up: and . Just click the one youre looking for, and keep on writing! If you need to do a lot of typing in French, you could get bogged down
using keyword shortcuts every time you need to type French accents. In this case, another option is to add an alternate keyboard layout in Windows. The options available for typing in French are the International keyboard, French keyboard, and Canadian French keyboard. The International keyboard is the most user-friendly to US-based users who
are used to a QWERTY-style layout. The French keyboard is AZERTY and has several keys in different places than a US English keyboard, which can make switching back and forth confusing. The Canadian French keyboard has all the unmodified letters in the same spots, but has some additional characters. When you use the International keyboard,
be careful when typing quotation marks and apostrophes before letters that accents aigu, cdilles, and trmas typically modify. If you dont put an extra space between the punctuation and the letter, itll assume that you want the accent mark. For example, for cest not to become cst, you would have to type it as c est and then go back and remove the
space. AccentCodeaigu ()Type ~ (to the left of 1), then the vowelgrave (, , )Type (apostrophe), then the vowelcirconflexe (, , , , )Type ~ (shift + 6), then the voweltrma (, , )Type (shift + ), then the vowelcdille ()Type (apostrophe) then ¢ The typing of the accents themselves is easier on the French and Canadian French keyboards. On the French
keyboard, several accent marks are available as keys. On the Canadian French, fewer are available as keys, but the codes are simpler. AccentFrench KeyboardCanadian French Keyboardaigu ()On key: number 2Type / (forward slash), then egrave (, , )On keys: number 0, number 7, apostropheType (apostrophe), then the vowelcirconflexe (, , , , )Type [
(left square bracket), then the vowel (q on English keyboard = a on French keyboard)Type [ (left square bracket), then the voweltrma (, , )Type shift + [ (left square bracket) and the vowelType Shift + ] (right square bracket), then the vowelcdille ()On key: number 9Type ] (right square bracket), then ¢ Once you decide which keyboard add-on you want
to use, heres how to enable it: Go to Settings. Click on Time & Language. Click on Language & Region. Click on English (United States). Click on the horizontal three dots, and choose Language options. Scroll down to Keyboards and click on Add a keyboard and choose your language. To toggle between keyboards, hold the Windows key and use the
space bar to choose your keyboard language. For everything you need to start having conversations in the language of love, begin with the indispensable guide to learning French. Already started and need some help mastering the language? Check out the top French tutors on Wyzant! If you often type in different languages, knowing how to type
accents on Windows 10 is super handy. By following a few simple steps, you can easily type accents like , , or without much hassle. Whether youre writing in Spanish, French, or any other language, this guide will show you how to get those accents on your keyboard. In this section, youll learn how to type accents on Windows 10. These steps will make
it simple to add accented characters to your text. First, open the Control Panel by searching for it in the Windows search bar. The Control Panel is where you can change most of your computers settings, including your keyboard settings. Next, click on Clock, Language, and Region. This section allows you to adjust language and keyboard settings on
your Windows 10 computer. Then, click on Language to see the list of installed languages. Here, you can add new languages or change your current language settings. Click on Add a language and choose the language you need. Selecting a new language will often come with keyboard layouts that support accented characters. After adding the
language, install the keyboard layout for that language. This will enable you to switch between different keyboard layouts easily. Press Windows key + Ctrl + O to open the on-screen keyboard. The on-screen keyboard shows you where the accented characters are located on your keyboard layout. Use the language bar to switch between different
keyboard layouts. You can find the language bar in the taskbar, and it allows you to switch layouts with just a click. When in the correct layout, use special keys like AltGr or dead keys to type accents. These special keys help you quickly type accented characters without needing to remember complex key combinations. After completing these steps,
you will be able to type accented characters effortlessly. Use the Alt code method: Hold down the Alt key and type a numeric code on the numeric keypad for specific characters. Create keyboard shortcuts: Customize your keyboard shortcuts for frequently used accents. Use character map: Access the character map via the Windows search bar for a
visual representation of all available characters. Practice: The more you practice, the easier it will be to remember how to type accents. Update your language settings: Ensure your language settings are always updated for the best performance. You can find a list of Alt codes online or use the character map in Windows to see them. Yes, you can use
Alt codes or the character map to type accents without changing your layout. Yes, some keyboard layouts have dead keys which allow you to type accents using the standard keyboard. You may need to download a language pack from the Microsoft website or use third-party software. Yes, but the steps might vary slightly. Check the specific
instructions for your version. Open the Control Panel. Go to Clock, Language, and Region. Click on Language. Add a Language. Install the Keyboard Layout. Use the On-Screen Keyboard. Switch Keyboard Layouts. Type Accents Using Special Keys. Typing accents on Windows 10 doesnt have to be a headache. By following these steps, you can easily
switch keyboard layouts and use special keys to add those important accents. Whether youre typing in Spanish, French, or any other language that requires accents, these tips and tricks will make your life much easier. Remember, the more you practice, the more natural it will become. Keep experimenting with different methods until you find the one
that works best for you. If you run into any issues, refer to the FAQs or revisit the steps to ensure you didnt miss anything. Happy typing!Matthew Burleigh has been writing tech tutorials since 2008. His writing has appeared on dozens of different websites and been read over 50 million times.After receiving his Bachelors and Masters degrees in
Computer Science he spent several years working in IT management for small businesses. However, he now works full time writing content online and creating websites.His main writing topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well.Read his full bio here.
Typing accents on Windows 10 keyboards can be daunting, especially if youre accustomed to working with the English language, which typically doesnt utilize accent marks. However, if youre involved in languages such as Spanish, French, German, and many others that require special characters, knowing how to type these accents correctly can be
crucial. In this comprehensive guide, well explore the various methods to type accents on Windows 10 keyboards, covering everything from keyboard shortcuts to alternative input methods. Understanding Accents and Their ImportanceAccents are diacritical marks used in many languages to modify the pronunciation or meaning of words. For
instance, the character "e" can take on different meanings when accentuated in various languages. In Spanish, "s" (yes) includes an accent to differentiate it from "si" (if), and in French, "caf" uses an accent to denote the pronunciation of the letter "e."When typing in a language that requires accents, it is essential not only for correct pronunciation but
also for clarity and correctness in communication. Consequently, learning to type these accents on a Windows 10 keyboard empowers you to type accurately in these languages.The Basic Accent Marks You Should KnowThe most common accent marks that you may encounter when typing are: Acute Accent () Often found in letters like , , and .Grave
Accent (') Used in letters like , , and .Circumflex Accent () Present in letters like , , and .Tilde (~) Used in letters like and .Diaeresis () Appears in letters like and .Each of these accent marks plays an important role in the pronunciation and meaning of terms in several languages.Setting Up Your Keyboard for AccentsBefore diving into specific methods
for typing accents, its a good idea to configure your keyboard for the best typing experience. Here are some preliminary steps:1. Language SettingsYou can add additional languages and keyboard layouts through Windows settings: Go to Settings > Time & Language > Language.Click on Add a language and select the language you need.After
installing, select the language and click Options.Here, you can add different keyboard layouts.Installing the language will help facilitate easier typing of accents, as many languages have keyboards designed specifically for their unique characters.2. Keyboard OptionsWindows 10 offers various keyboard layouts that make typing accents easier. For
instance, QWERTY, AZERTY, and QWERTZ are common layouts used in different countries. You might want to switch between these layouts based on your typing needs.For a seamless experience, you can change your keyboard layout by using a keyboard shortcut: Windows Key + Spacebar Switch between your installed keyboard layouts.Methods to
Type Accents on Windows 100nce your keyboard is configured correctly, multiple methods are available to type accents in Windows 10.1. Using Keyboard ShortcutsOne effective method is to utilize special keyboard shortcuts. Here are some common methods for typing various accents:Using Alt CodesBy using the Alt key in combination with a
numeric code on the numeric keypad, you can quickly type accented characters. Make sure to enable Num Lock for this method to work: : Alt + 160: Alt + 130: Alt + 161: Alt + 162: Alt + 163: Alt + 164: Alt + 129To use, hold down the Alt key, type the code on your numeric keypad, and release the Alt key.Using Recent Keyboard ShortcutsAnother
useful set of shortcuts, especially for commonly used letters, are as follows:Ctrl + (apostrophe), then a letter (for acute accents): Example: Ctrl + + e = Ctrl + * (grave accent), then a letter (for grave accents):Example: Ctrl + ° + e = Ctrl + Shift + © (caret), then a letter (for circumflex):Example: Ctrl + Shift + ~ + o = Each of these shortcuts allows
you to quickly assay letters with respective accents. 2. Character MapWindows includes a built-in tool called Character Map that allows users to access a variety of characters, including those with accents. Heres how to use it:Press Windows Key + R to open the Run dialog box.Type charmap and press Enter.This brings up the Character Map app. You
can scroll through to find the accented character you need or use the search feature to find specific ones.Once you find the character, simply select it, click Select, then Copy and paste it where you need it.3. Touch KeyboardFor users with a touchscreen or tablet mode, the touch keyboard in Windows 10 also supports accent typing:Right-click on the
taskbar and select Show touch keyboard button.Click on the touch keyboard icon, and then on the keyboard that appears, you can long-press the relevant letter for accent options.For example, long-pushing the "e" key will present options like , , , and so forth. 4. Third-party SoftwareFor frequent typists in specific languages, consider third-party
applications that enhance typing capabilities. Applications like Microsofts Word, Notepad++, or Google Docs can provide specialized keyboard settings for various languages and accents.5. Custom Keyboard LayoutsIf you often find yourself needing specific accents or characters, creating a custom keyboard layout can simplify your
workflow:Download the Microsoft Keyboard Layout Creator (MKLC).Create a new layout based on your current keyboard and add the characters you frequently use.Save and install the new layout to have quick access to your desired characters.This method requires a bit more initial setup but pays off in improved efficiency over time. 6. Copy and
Paste MethodIf you find yourself needing accents on an ad-hoc basis, simply copying and pasting from the internet can be a quick solution:Search for the accented character on Google or use an online character map.Copy the character.Paste it into your document as needed.7. Language-Specific KeyboardsAs mentioned earlier, if youre
communicating frequently in a particular language, you can change your entire keyboard layout to reflect that language:Go through the Settings > Time & Language > Language menu.After adding a language, choose the associated keyboard layout.Utilizing a language-specific keyboard layout will allow you to type accents more naturally without
needing shortcuts or character maps. ConclusionTyping accents on a Windows 10 keyboard can significantly impact clarity and communication in various languages. With multiple methods available, including keyboard shortcuts, character maps, touch keyboards, third-party software, custom keyboard layouts, and copying-pasting, you can choose the
method that fits your typing style and needs best.Whether you are a casual user or someone who frequently communicates in different languages, understanding how to type accents effectively is an invaluable skill. By mastering these techniques, you can enhance your typing efficiency and ensure that your writing remains accurate and legible. With
practice, typing accented characters will become second nature, opening up a world of written communication in diverse languages. HTTA is reader supported. When you buy through links on our site, we may earn an affiliate commission at no extra cost to you.Learn more. French has a standard set of 26 letters. In addition to these letters, French
uses several accents. They are about five of them as listed below: Laccent aigu () e with the Acute Accent.Laccent grave (, , ) a, € and u with the Grave Accent.Laccent circonflexe or chapeau (, ,,, ) a, e, i, 0, and u with the Circumflex Accent.La cdille () C with the Cedilla accent.Le trma (, , ) e, i, and u with the umlaut accent. This guide will teach you
how to type special French Letters on a Mac or Windows PC using shortcuts on the English keyboard. There are different methods for typing these characters for different documents depending on the Operating System you are using. Youll pick up each of these techniques in no time. Lets get started. To type the Special French Letters with Accents
on the English keyboard, press and hold the alt key, then using the numeric keypad type the Character alt code as below: To type French letter Laccent aigu (), press Alt + 0201 for uppercase or Alt+0233 for lowercase.To type French letter Laccent grave (, , ), press Alt + 0192, Alt + 0200, Alt + 0217 respectively for uppercase. To type lowercase,
press Alt + 0224, Alt + 0232, Alt + 0249 respectively.To type French letter Laccent circonflexe (, , , , ), press Alt + 0194, Alt + 0202, Alt + 0206, Alt + 0212, Alt + 0219 respectively for uppercase. To type the lowercase, press Alt + 0226, Alt + 0234, Alt + 0238, Alt + 0244, Alt + 0251 respectively.To type French letter La cdille (), press Alt + 0199 for
uppercase and alt + 0231 for lowercase.To type French letter Le trma (, , ), press Alt + 0203, Alt + 0207, Alt + 0220 respectively. To type the lowercase, press Alt + 0235, Alt + 0235, Alt + 0252 respectively. The table below lists all of the alternate characters for each of the Special French Letters both lowercase and uppercase (i.e., small and capital
letters). DescriptionFrench LettersKeyboard Alt codeFrench Letter E Acute UppercaseAlt + 0201French Letter e Acute LowercaseAlt + 0233French Letter A Grave UppercaseAlt + 0192French Letter a Grave LowercaseAlt + 0224French Letter E Grave UppercaseAlt + 0200French Letter e Grave LowercaseAlt + 0232French Letter U Grave
UppercaseAlt + 0217French Letter u Grave LowercaseAlt + 0249French Letter A Circumflex UppercaseAlt + 0194French Letter a Circumflex LowercaseAlt + 0226French Letter E Circumflex UppercaseAlt + 0202French Letter e Circumflex LowercaseAlt + 0234French Letter I Circumflex UppercaseAlt + 0206French Letter i Circumflex
LowercaseAlt + 0238French Letter O Circumflex UppercaseAlt + 0212French Letter o Circumflex LowercaseAlt + 0244French Letter U Circumflex UppercaseAlt + 0219French Letter u Circumflex LowercaseAlt + 0251French Letter C Cedilla UppercaseAlt + 0199French Letter c Cedilla LowercaseAlt + 0231French Letter E Umlaut UppercaseAlt +
0203French Letter e Umlaut LowercaseAlt + 0235French Letter I Umlaut UppercaseAlt + 0207French Letter i Umlaut LowercaseAlt + 0239French Letter U Umlaut UppercaseAlt + 0220French Letter u Umlaut LowercaseAlt + 0252 Below is a step-by-step guide to type any of these Special French Characters with the help of the alt codes in the
above table. To begin, open the document in which you want to type the Special French Letters. It could be Microsoft Word, Excel, PowerPoint, or even in your web browser.Press the Num Lock key to turn it on. In other words, make certain that the numeric keypads keys are not disabled.Hold down the Alt key and type the alt code of the Special
French character you want to type using the numeric keypad. The table above contains all the alt codes for the various French Letters.Now release the Alt key after typing the alt code with the numeric keypad. NOTE: This option is only for Windows users. To type French Letters on Mac, refer to the next option. A keyboard shortcut is the quickest
way to type French Letters on a Mac. Each letter with a French Accent mark has its own unique shortcut. They all, however, use a very similar keystroke pattern. Lets look at how to type any of these characters on a Mac using keyboard shortcuts. DescriptionFrench LettersShortcut for MacFrench Letter E Acute[OPTION]+[e] then eFrench Letter A
Grave[OPTION]+["] then aFrench Letter E Grave[OPTION]+[ ] then eFrench Letter U Grave[OPTION]+["] then uFrench Letter A Circumflex[OPTION]+[i] then aFrench Letter E Circumflex[OPTION]+[i] then eFrench Letter I Circumflex[OPTION]+[i] then iFrench Letter O Circumflex{OPTION]+[i] then oFrench Letter U Circumflex OPTION]+[i] then
uFrench Letter C Cedilla[Option] + [Shift] + [C]French Letter E Umlaut[OPTION]+[u] then eFrench Letter I Umlaut[OPTION]+[u] then iFrench Letter U Umlaut[OPTION]+[u] then u To use the Mac Keyboard shortcuts to type Special French letters with accent marks, first open the document that will contain the character and simultaneously press
and release Option plus the corresponding key (see above table), then press the French letter you want to type. Note: If you want to type uppercase French Letters on Mac, use the above hotkeys whilst your caps lock key is turned on. For more options on how to type these characters specifically in Microsoft Word, Excel, or PowerPoint, refer to the
remaining sections below. NOTE: As shown already, using Option 1 (Alt code for Windows) and Option 2 (shortcut for Mac), you can easily type French letters with Accent in Word. However, you can continue reading below if you want to learn more methods about how to insert these characters specifically into your Word document. In addition to the
alt code method, there are two other ways to insert the French letters with Accent in Microsoft Word. The first method involved using the insert symbol dialog box, while the second method involved using a keyboard shortcut that only works in Word. Lets explore these options one after the other. To insert the French special letters using the insert
symbol dialog box, obey the following instructions: Open up your Word document and place the cursor where you want to insert the Character.On the Insert tab, go to Symbols > Symbol > More Symbols. The Symbol dialog box will appear. Select Latin-1 Supplement from the Subset: drop-down list. This will display all the symbols under this category
including lowercase and uppercase French Letters.Locate the French letter you wish to insert and double-click on it. Alternatively, click to select your desired French Letters and click on the Insert button to insert it into your document. These are the steps you may use to insert these symbols in Word using the Insert Symbol dialog box. Each of the
French special letters has its own set of keystrokes. These keystrokes or shortcut keys are only designed to function in Microsoft Word. Thus, if you want to type these symbols in a program other than Word, look into the other options in this post. Below are the various shortcuts to type French Letters in Microsoft Word: DescriptionFrench
LettersShortcut for MS WordFrench Letter E AcuteCtrl+ (apostrophe), then eFrench Letter A GraveCtrl+ (accent grave), then aFrench Letter E GraveCtrl+" (accent grave), then eFrench Letter U GraveCtrl+  (accent grave), then uFrench Letter A CircumflexCtrl+Shift+~ (caret), then aFrench Letter E CircumflexCtrl+Shift+~ (caret), then eFrench
Letter I CircumflexCtrl+Shift+~ (caret), then iFrench Letter O CircumflexCtrl+Shift+”~ (caret), then oFrench Letter U CircumflexCtrl+Shift+ " (caret), then uFrench Letter C Cedilla[Ctrl] + [, ], [ ¢ JFrench Letter E UmlautCtrl+Shift+: (colon), then eFrench Letter I UmlautCtrl+Shift+: (colon), then iFrench Letter U UmlautCtrl+Shift+: (colon), then
u NOTE: These keystrokes will give you Lowercase Special French Letters. However, if you want uppercase characters, turn on the caps lock whilst typing the shortcuts. These are the shortcuts for typing these letters in Microsoft Word. If you are using a Windows PC, you can easily type any letter with the French Accent mark in Excel. Mac users can
also use the shortcuts stated in section two of this tutorial. However, if you are looking for another way to achieve this specifically in Microsoft Excel, the steps below will show you. To insert Accent on French Characters in Excel: Launch Excel.Select the cell that will contain the character.On the Insert tab, click on the Symbols drop-down button and
select Symbol from the list. The Symbols Dialog box will appear. From the Subset: drop down list, select Latin-1 Supplement. All the symbols under this group will appear including all lowercase and uppercase French Letters. Click to select the particular French special letters you want to insert, then click on the Insert button. Alternatively, double
click on the symbol to insert it into your Excel document. These are all the steps needed to insert any of the French letters with Accent on top. See Also: How to type Special German Letters on Keyboard Just like on Microsoft Word and Excel, you can use the French letters with Accent alt code to type them into your PowerPoint document. However, if
you want another way to perform this task especially for PowerPoint, keep reading. To insert French letters with Accent in PowerPoint: Open your PowerPoint document.Place the insertion pointer on the slide you need the character.Go to the Insert tab on the ribbon. Click on the Symbols button to launch the Symbol dialog box. The Symbol dialog box
will appear. From the Subset drop-down list, select Latin-1 Supplement. You should see all the French characters under this category of symbols.Select the particular French letter you wish to insert and click on the Insert button. Otherwise, just double-click on the symbol you want to insert into your PowerPoint document. These are the steps you
need to be able to insert the Special French Letters in Microsoft PowerPoint using the Insert symbol dialog. Another easy way you can get the French Letters on any PC (whether Windows or Mac) is to use my favorite method:copy and paste. All you have to do is to copy the symbol from somewhere like a web page or the character map for windows
users, and head over to where you need the symbol (say in Word, Excel, or PowerPoint), then hit Ctrl+V to paste. Below are the French Letters for you to copy and paste into your Word document. Just select your desired symbol and press Ctrl+C to copy, switch over to your document, place your insertion pointer at the desired place, and press Ctrl+V
to paste. Copy & Paste Special French Letters You can also use the Character Map to copy and paste any symbol or character on Windows. It contains every symbol or character you can think of. Obey the following instructions on how to use the Character Map on any Windows PC. Click on theStartbutton and search for Character Map. The Character
Map app will appear in the search results, click on it to open. The Character Map dialog will appear.Select the French Letters you want to insert by double-clicking on it, it should appear in theCharacter to copy:field, then click on theCopybutton to copy the symbol.Switch to your document where you want to paste the copied symbol, place the
insertion pointer at the desired location and press Ctrl + V to paste. This is how you may use the Character Map dialog to copy and paste any symbol on Windows PC. Among all these several options to type the Special French Characters, I think using the alt code method for Windows is the fastest option, provided you know the alt code for that
particular symbol you want to type. If you happen to use the Special French Characters often, you may consider making a cheat sheet for your reference. Using the keyboard shortcut to type French letters is also a handy method for Mac users. However, you can also use the mouse-based approach if you are inserting these symbols in any of the Office
programs like Word, Excel, or PowerPoint. How To Type French Accents On English Keyboard Windows 10 Typing French accents on an English keyboard can be a bit of a challenge, especially for English speakers unaccustomed to using diacritical marks. French is full of accents that change the pronunciation and meaning of words, making it
essential for both practical and accurate communication. Fortunately, Windows 10 provides several methods to facilitate the typing of these accents, even if youre using a standard English keyboard. In this article, well explore various ways you can easily input French accents, ensuring that your communication in French is up to par.The Importance
of French AccentsBefore diving into how to type French accents, its vital to understand their significance in the French language. Accents are not mere decorative elements; they affect pronunciation and meaning. Here are a few common French accents and their implications:Accent aigu (): This accent indicates that the vowel is pronounced with a
stress on the "e" sound. It is crucial as it can change the meaning; for example, "a" means "has" (from the verb avoir) while "" means "to" or "at."Accent grave (, , ): This accent can affect the pronunciation of "e" and is essential for distinguishing words. For instance, "0" means "where," while "ou" means "or."Accent circonflexe (, , , , ): This accent
often indicates that historically there was an "s" following the vowel; for example, "fort" (forest).Cdille (): This accent changes the pronunciation of "c" from a hard sound (as in "cat") to a softer sound (as in "cent").Trma (, , ): This diacritical mark indicates that the vowel should be pronounced separately from the preceding vowel.Understanding these
elements can help enhance your language skills, making it easier to communicate effectively in French. Typing French Accents on an English Keyboard in Windows 10Now that we appreciate the significance of these accents, lets delve into how to type them on a Windows 10 English keyboard. Well cover three primary methods: using keyboard
shortcuts, Windows Language settings, and the Character Map.Method 1: Keyboard ShortcutsUsing keyboard shortcuts is often the fastest way to type accents in French. Here are some common shortcuts you can use. Ensure you have the Num Lock key activated, as these shortcuts typically require the numeric keypad.Accent aigu (): Press Alt +
0233Accent grave (): Press Alt + 0232Accent grave (): Press Alt + 0226Accent grave (): Press Alt + 0249Accent circonflexe (): Press Alt + 0234Cdille (): Press Alt + 0231Trma (): Press Alt + 0235These shortcuts are invaluable when typing in French, and once you practice them, typing with accents will become second nature. Method 2: Changing
Your Keyboard LayoutAnother effective way to type French accents is by changing your keyboard layout to French. This method allows for quicker access to accented letters without the need for complex shortcuts or guessing. To change the keyboard layout on Windows 10, follow these steps:Open Settings: Click on the Start menu and select the gear
icon to open the settings.Time & Language: Go to Time & Language in the settings menu.Language: Click on Language in the left sidebar.Add a Language: Under the Preferred languages section, click on Add a language.Select French: Type French into the search bar and select the appropriate version (e.g., French (France)) from the list.Set as
Default: After adding it, click on it and select Set as default.Switching Keyboard Layout: To switch between layouts, you can either use the language bar on the taskbar or press Alt + Shift or Windows + Space to cycle through your keyboard layouts.Now, with the French keyboard layout, you can type accented characters directly. The layout will vary
depending on the specific version of French you choose: is located on the number 2 key. is on the key where the number 7 is in the English keyboard. is located on the key next to the letter A. can be found on the key which has =" in English.With a French keyboard layout, many accented characters will be easily accessible without needing to
remember specific shortcuts. Method 3: Using the Character Maplf you only need to occasionally input French accents, you can use the Character Map tool in Windows 10. Heres how:Open Character Map: Type "Character Map" into the Windows search bar and open the app.Find the Character: In the Character Map, you can browse through the
available characters. Use the Advanced view checkbox if you want to search for a specific character or filter by the character set.Select and Copy: When you find the accent you want, click on it, select Copy, and then paste it into your document using Ctrl + V.While the Character Map method isnt as efficient for frequent users of French accents, it
can be a useful option for infrequent needs.Method 4: Using Alt Codes Without Num LockSome laptops may not have a dedicated numeric keypad, making it impossible to use the Alt codes directly. A workaround is to use the number keys at the top of your keyboard instead of the numeric keypad. Heres how to do that: Enable Num Lock: Ensure Num
Lock is turned on. You can find this key and use it to enable the numeric keypad embedded in the letter keys.Type the Code: Hold down the Alt key while typing the corresponding number code on the number keys: (Alt + 130 or 0233 using the number keys at the top). (Alt + 138 or 0232). (Alt + 136 or 0234). (Alt + 135 or 0231).This method is
effective on most laptops, but remember that it still requires using the Alt key alongside your keyboard for shortcut combinations.Method 5: Using Microsoft Word FunctionalityIf you write extensively in French, and you often use Microsoft Word for your documents, specific features in Word can facilitate typing accents:AutoCorrect Options: You can
set up AutoCorrect options to automatically convert certain sequences into accented characters. For instance, you can program Word to change el into . To do this:Click on File in the top-left.Select Options.Then choose Proofing.Click on AutoCorrect Options.Under the AutoCorrect tab, enter your replacements, such as el for, and add it to the
list.Insert Symbols: You can also go to the Insert tab and choose Symbol. You can select accented characters from there and add them to your document. Shortcut Keys: In addition to the AutoCorrect feature, you can assign keyboard shortcuts to specific symbols in the Symbol dialogue. After finding the character, click on Shortcut Key to establish a
new keyboard combination.SummaryTyping French accents on an English keyboard in Windows 10 may seem daunting at first, but with the right methods, youll find it quite straightforward. Whether using keyboard shortcuts, changing keyboard layouts, utilizing the Character Map, or leveraging features in Microsoft Word, you can ensure accurate
and appropriatetexts in French. Mastering these techniques will not only enhance your typing efficiency but will also help improve your fluency in the language as you become more accustomed to recognizing and using these essential diacritical marks. As you become more familiar with these methods, youll find that composing messages, essays, or
any text in French becomes a seamless task.Incorporating French accents into your writing is more than just a technical skill; it signifies respect for the languages nuances and promotes clearer understanding. So practice these methods, and soon youll be typing in French with all the accents, ensuring that every word you type conveys the intended
meaning clearly and accurately.
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